


  LabelPro For Windows 
Welcome to Avery LabelPro for Windows, the fast and easy way to create great-looking Avery
labels, index dividers, and other Avery products.
Click here if you have the LabelPro Working Model that comes on one disk.
LabelPro allows you to create custom designs in minutes for Avery labels and other Avery 
supplies using scaleable fonts, graphic images, bar codes and more.

Merge your existing database files of any size directly from popular file formats.
Use built-in clip art or import corporate logos and other custom images.
Store addresses and other lists for future use. 
Add postal bar codes with built-in USPS bar code capability.
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About This Quick-Start
This Quick-Start provides some basic information to help you get started with LabelPro. The 
Quick Start to Using LabelPro will show you how to use the three principal components of 
LabelPro: the Designer window, the List Manager window, and the Merge window.
For more complete information on any subject, refer to the on-line help which provides an 
exhaustive reference to LabelPro.
When you need information on how to use a particular feature, use QuickSteps, an on-screen
step-by-step reminder for important procedures in LabelPro that's built into Help.
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LabelPro Overview
Printing an entire page, or multiple pages, of identical labels is easy with LabelPro. You 
simply create a design, and print.
LabelPro can quickly and easily print Avery labels (and other Avery supplies) using 
information you have stored in a list. For example, you may want to print labels for everyone
in your address list. For those occasions when you want to print information stored in a list, 
you will use the List Manager and Designer windows. You can also print information from lists
that were created in other programs, such as WordPerfect, Microsoft Word, Word for 
Windows, Paradox, dBASE, or any program that can create a delimited file. Finally, you can 
print labels containing the same text on every label, for example, return address labels.
The key to understanding how the List Manager and Designer windows work together lies in 
understanding the difference between the way they handle lists. The List Manager stores 
addresses and other list information (in a way that's easy to sort and edit); the Designer 
links the list to your design and prints it. 
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Before You Begin...
Read these tips to get started instantly with LabelPro for Windows.

Tips for using LabelPro
Click twice on text you want to edit. On the first click, sizing handles appear on the 

corners of the box around the text. On the second click, an insertion point appears. When 
the insertion point appears inside the box, you can edit as in any Windows program.

LabelPro's tool buttons are used to create elements on a label design. When you click
a tool, the mouse pointer changes to show you which tool is selected. Drag the mouse to 
create a new text or graphics box, or click the Arrow tool to restore the arrow pointer.

If you click a tool by mistake, click the Arrow tool or press Esc to restore the arrow 
pointer.

Use Help. LabelPro's on-line help is designed to help you wherever you are in 
LabelPro and contains all the information you need to use LabelPro. Inside Help youll also 
find QuickSteps. QuickSteps provide an on-screen reminder of the steps to complete many 
of the procedures described in the how-to section of Help.

LabelPro prints big mailing lists faster if you turn off Windows Print Manager. Use the 
Printers icon in Control Panel to clear the Use Print Manager check box.



Starting LabelPro
1. In the Windows Program Manager, open the Avery Products program group and find the 

Avery LabelPro icon.

2. Double-click on the Avery LabelPro icon.    
LabelPro displays the Designer window. From here, you can design and print a label 

or choose List Manager to do list management tasks.
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Starting a Design
1. From the File menu, choose New Design.

LabelPro displays the New Design dialog box.
2. Choose the type of product (and orientation, if applicable) you want to use from the Type 

drop down list.
Many of the product types are available in portrait and landscape orientations.

NOTE: In LabelPro for Windows, portrait and landscape 
orientation refer to the orientation of the individual label 
(or other Avery product)--and not the orientation of the 
page.

3. Select the product you want to use from the Products list box.
Take a moment to click on a few of the products to see the available sizes. The image to 
the right of the Products list box shows you how the labels appear on the sheet. 

4. Choose the OK button.
LabelPro opens the selected product and displays it in the Designer window.
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Quick Start: Printing Identical Labels
Use the Designer to create a design (see the Designer window below). 

Now you can simply type your text and print as many identical labels as you like. You can 
add graphics or shapes using the Designer tools.
Click twice on text you want to edit. On the first click, sizing handles appear on the corners 
of the box around the text. On the second click, an insertion point appears. When the 
insertion point appears inside the box you can edit as in any Windows program.
Printing Lists with LabelPro 



Quick Start: Printing Lists
The quick tour on the following pages shows how easy it is to print information stored in a 
list. By following these simple steps, you will be able to print information from a variety of 
list formats quickly and easily. 

1. Create a Design 
2. Click the AutoMerge Tool 
3. Add Merge Fields 
4. Print the Design 



 Create a design
Use the Designer to create a design with a text object (see the Designer window below). 

Now you can simply type your text and print as many identical labels as you like, or follow 
the steps below to print from a list. 
Click twice on text you want to edit. On the first click, sizing handles appear on the corners 
of the box around the text. On the second click, an insertion point appears. When the 
insertion point appears inside the box you can edit as in any Windows program.
2. Click the AutoMerge Tool 
Using the Designer Tools 



 Click the 
 AutoMerge Tool

The AutoMerge tool steps you through the merge process, beginning with the Link to List 
dialog box below. 

3. Add Merge Fields 



 Add Merge Fields
The Merge Fields dialog box (shown below) appears so you can add the fields you want to 
print . 

4. Print the Design 



 Print the Design
Use the Print command on the File menu to print your completed design (see the design with
merged data below). You can use the Print Preview command on the Print menu to check 
each record in your list.

Use the Show Merge Fields and Show Merge Text commands on the View menu to see either 
the names of the fields you have merged or the text of the first record in the linked list. 
Using the Designer Tools 



Using the Designer Tools
The Designer tools comprise the toolbar, which is displayed either horizontally just under the
menu bar, or vertically along the left edge of the screen. It contains icons that represent the 
most-often used functions in Designer. 
To use a tool, simply point to the tool you want to use, click the left mouse button and move 
the mouse to the Design workspace.    The mouse pointer changes to show you which tool is 
selected. Drag the mouse to create a new text or graphics box, or press Esc to restore the 
arrow pointer. Use the tools to create new objects, not to edit or move existing objects.
Each tool in the toolbar has a corresponding menu command which can also be chosen from 
the menu bar. For example, the Text tool can be also be selected by choosing Text from the 
Objects menu (Alt, O, T).

If you click a tool by mistake, click the Arrow tool, or press Esc to restore the arrow 
pointer. 
The following table presents each tool in the toolbar and its meaning.

Button Clicking this tool lets you:
Restore the pointer so you can 
select, move and size objects.
Add text and special fields to your 
design
Add a bit-mapped graphic to your 
design
Add a bar code to your design

Draw straight lines 

Draw rectangles and squares with 
sharp corners
Draw rectangles and squares with 
rounded corners
Draw ellipses and circles

Print one page or one set of the 
current design.
Step you through merge setup.

Open the List Manager

Using Help 

Using Help
Help is just a keystroke away whenever you are using LabelPro. Use the on-line help to get 
an overview of how a feature works or get step-by-step instruction on how to use a feature 
with QuickSteps.



The on-line help is a complete reference for LabelPro. It has detailed information on every 
aspect of using LabelPro and contains useful information not found in this manual. The on-
line help also includes a glossary where frequently used terms are defined.
To get help when you are in LabelPro, press F1 or click on Help in the menu bar.    
Searching Help for a topic 
Using QuickSteps 



Searching Help for a topic
LabelPro's Help is fully indexed, just like a book. Use the Search button in Help to search for 
a word or phrase.

To search for a Help topic
1. From the Help menu, choose Search for Help On.

LabelPro displays the Search dialog box.
2. Type the first few letters of the term you want to search for.

As you type, Help displays new keywords in the list box.

3. Double-click a keyword related to your subject (or select a keyword and press ENTER).
Help displays the relevant topics for that keyword.

4. Double-click your topic (or select the topic you want and press ENTER).
Using QuickSteps 



Using QuickSteps
QuickSteps provide a brief summary of the steps required to complete a task. QuickSteps 
remain on your screen, on top of all your other windows, until you click the Close button in 
the QuickSteps window.

To use QuickSteps
1. From the Help menu, choose QuickSteps; the LabelPro QuickSteps screen is displayed.
2. Select the topic you want to learn about.

A QuickSteps window displaying information about the topic you have chosen is 
displayed on top of your other windows.

3. Follow the steps in the window to complete your task.
You can get additional information about the task by clicking on the highlighted (and 
underlined) terms and phrases in the QuickSteps window.

NOTE: When using QuickSteps, you can quickly return to
your screen of origin at any time by clicking the Close 
button in the QuickSteps window.

4. Choose the Close button when you have completed the task.
Using Help 
Quitting LabelPro 



Quitting LabelPro

From the File menu, choose Exit.
NOTE: To remove LabelPro from your computer, run the 
Setup program again and follow the instructions on the 
screen to de-install the program.

Changing the Selection of Avery Products
You can change the selection of Avery products that are available in LabelPro by using the 
LabelPro Product Setup program.
1. In the Windows Program Manager, open the Avery Products program group and find the 

LabelPro Product Setup icon.

2. Double-click on the LabelPro Product Setup icon.    
The LabelPro Product Setup window is displayed. From here, you can add or remove 

groups of products. Click the Help button for more information.
NOTE: To change to a different Avery product within 
LabelPro, use the New Design command on the File 
menu. You can choose from any listed Avery product in 
the New Design dialog box.    See Starting a Design.

Ordering a Printed Manual
If you received this copy of LabelPro without a manual (on a CD-ROM, for example), you can 
order a printed manual for LabelPro for Windows through the Avery Consumer Service 
Center. 
You can call the Consumer Service Center, at (800) 252-8379 between the hours of 7 A.M. 
and 4 P.M. (Pacific time) Monday through Friday.

Call the Consumer Service Center to purchase manuals and upgrades for Avery 
software products. 

Avery's Consumer Service Center provides product information for all Avery products 
sold in the US and Canada. 

Call the Consumer Service Center to find where to purchase Avery products. They can
help you get products quickly, even if the products are not carried by dealers in your area.

You cannot reach Avery Technical Support by calling this number. See LabelPro's on-
line help for information on Avery's product support services.



Avery License Agreement
Carefully read all the terms and conditions of this agreement prior to Using the software. 
Using the software indicates your acceptance of these terms and conditions. If you do not 
agree to these terms and conditions, discard or destroy the software.
1. LICENSE:    You have the non-exclusive right to use the enclosed program.    This program 
can only be used on a single computer.    You may physically transfer the program from one 
computer to another provided that the program is used on only one computer at a time.    
You may not electronically transfer the program from one computer to another over a 
network.    You may not distribute copies of the program or documentation to others.    You 
may not modify or translate the program or related documentation without the prior written 
consent of Avery. 
You may not use, copy, modify, or transfer the program or documentation, or any copy, 
except as expressly provided in this agreement.
2. BACKUP AND TRANSFER:      You may make one (1) copy of the program solely for backup 
purposes.    You must reproduce and include the copyright notice on the backup copy.    You 
may transfer and license the product to another party if the other party agrees to the terms 
and conditions of this Agreement and completes and returns a Registration Card to Avery.    If
you transfer the program, you must at the same time transfer the documentation and 
backup copy or transfer the documentation and destroy the backup copy.
3. COPYRIGHT:    The program and its related documentation are copyrighted.    You may not 
copy the program or its documentation except for backup purposes and to load the program 
into the computer as part of executing the program.    All other copies of the program and its 
documentation are in violation of this Agreement.
4.    TERM:    This license is effective until terminated.    You may terminate it by destroying 
the program and documentation and all copies thereof.    This license will also terminate if 
you fail to comply with any term or condition of this Agreement.    You agree, upon such 
termination, to destroy all copies of the program and documentation.
5.    LIMITED WARRANTY:    The program is provided as is without warranty of any kind, except
as stated herein.    The entire risk as to the result and performance of the program is 
assumed by you.    Should the program prove defective, youand not Avery or its 
dealersassume the entire cost of all necessary servicing, repair, or correction.    Further, 
Avery does not warrant, guarantee, or make any representations regarding the use of, or the
result of the use of, the program in terms of correctness, accuracy, reliability, currentness, or
otherwise, and you rely on the program and results solely at you own risk.
Avery does warrant to the original licensee (purchaser) that the disk(s), on which the 
program is recorded, be free from defects in materials and workmanship under normal use 
and service for a period of ninety (90) days from the date of original retail purchase as 
evidenced by a copy of your dated receipt.    In the event such disk is proven to be defective,
Avery's entire liability and your sole and exclusive remedy shall be replacement of the disk 
not meeting Avery's Limited Warranty and which is returned to Avery with a copy of your 
dated receipt.    If failure of the disk has resulted from accident, abuse, or misapplication of 
the product, then Avery shall have no responsibility to replace the disk under this Limited 
Warranty.
The above is the only warranty of any kind, either expressed or implied, that is made by 
Avery on this avery product.    The warranties of merchantability and fitness for a particular 
purpose are hereby specifically disclaimed by Avery and all other parties involved in the 
creation, production , or delivery of this program.    This warranty gives you specific legal 
rights and you may also have other rights that vary from state to state.



Neither Avery nor anyone else who has been involved in the creation, production, or delivery
of this program shall be liable for any direct, indirect, special, consequential, or incidental 
damages whatsoever (whether based upon contract, tort, or any other legal theory) arising 
out of the use, the results of the use, or inability to use such product even if Avery has been 
advised of the possibility of such damages or claim.    Some states do not allow the exclusion
of limitation of liability for consequential or incidental damages, so the above limitation may 
not apply to you.
6.    MISC.:    This License Agreement shall be governed by the laws of the State of California 
and shall inure to the benefit of Avery Dennison Corporation, its successors, administrators, 
heirs, and assigns.
7. ACKNOWLEDGMENT:    You acknowledge that you have read this agreement, understand it,
and agree to be bound by its terms and conditions.    You also agree that this supersedes all 
proposals or prior agreement, verbal, or written, and any other communications between the
parties relating to the subject matter of this agreement.
Should you have any questions concerning this agreement, before using the software please
contact in writing: Avery Dennison Office Products, 20955 Pathfinder Road, Diamond Bar, 
California 91765.



LabelPro Working Model
This is a working model of Avery LabelPro for Windows. It is fully functional, and will print on 
the full line of Avery labels and other Avery products for laser, ink jet and dot matrix printers.
There are several differences between this demonstration version and the retail version of 
LabelPro.
This working model has only a few of the 35 clip art images that are included in the retail 
version of LabelPro. The sample designs and lists that are included in this working model are
different from those that are included in the retail version of LabelPro. LabelPro's Help 
describes the sample designs and lists that are included in the retail version of LabelPro.
This working model will only merge dBASE and delimited (CSV) files. The retail version of 
LabelPro will also read WordPerfect, Word for Windows, and Paradox files.
This working model of LabelPro will cease to function after a specified number of uses. 
Follow the instructions on the opening screen to order a license, which will allow you to 
continue using LabelPro. When you order, you will receive a copy of the latest version of 
LabelPro for Windows and a complete LabelPro Users Guide.
 




